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Introduction 

This Getting Started document will help you to install and configure the Hardware and 
Software tools necessary to operate the Free TriCore Entry Tool Chain. At the end of the 
instructions described in this document, you will have a running environment that could 
be used as a starting point for further development or evaluation work. 

This tutorial goes step-by-step through the necessary procedures in order to: 

➢ Install the Free TriCore™ Entry Tool Chain. 

➢ Set up a project. 

➢ Configure the Evaluation Board and connect it to the PC. 

➢ Debug your application. 

 

If you need more information, please contact your nearest Infineon sale’s office. Contact 
information is available on Infineon web site: https://www.infineon.com.  

We wish you a lot of success with the Free TriCore Entry Tool Chain! 

 

Note: "Starter Kit Evaluation Board", "Evaluation Board", "TriBoard" and "Target" 
terminology are used to denote Evaluation Boards as shown in Figure 15 to Figure 33. 

 ! 

https://www.infineon.com/
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Installing the AURIX TC3xx - Free 
Entry Tool Chain 

Before you start 

To execute this Getting Started, it is necessary to have a  

➢ Microsoft Windows compatible PC equipped with USB port 

➢ Operating System Windows 7, Windows 8.1, Windows 10 64-bit  

➢ Power user’s or administrator rights are mandatory to install the required 
programs 

➢ During installation a connection to the internet is required 
for license activation 

All the items below are included in the Starter Kit. 

➢ Power Supply  (AC/DC converter) (5.5V – 60V) for the Starter Kit Board (optional) 

➢ TriCore Family Starter Kit Evaluation Board  

➢ Free TriCore Entry Tool Chain installation package 

➢ USB cable. 

System Requirements 
Before installing, make sure the following minimum system requirements are met: 

 

 Minimum Recommended 

CPU 
Intel Core i5™ 2.5 GHz and 
comparable 

Intel Core i7™ 3.5 GHz and 
comparable 

RAM 4 GByte 8 GByte 

Free disk space 3 GByte HDD 8 GByte SSD 

Display SXGA WUXGA 

Operating System Windows 10 64-bit Windows 10 SP1 64-bit 
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Additional requirements 

➢ On-line connection to the Internet 

➢ Microsoft .NET™ Framework 4 

➢ Adobe® Acrobat Reader 10 or higher 

➢ Administrator permissions for the current login during installation. 

Installation 
1. From the installation package run the installer setup.exe. Free TriCore Entry Tool 

Chain dialog appears (Figure 1). 

 
Figure 1 Free TriCore Entry Tool Chain Setup dialog 

 

2. Select Next button. The License Agreement dialog appears. Please read carefully 
and agree or cancel the installation with Cancel button (Figure 2). 

 
Figure 2 License Agreement dialog 
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3. Click Next button. It is recommended to choose the full installation with all 
components (Figure 3). 

 
Figure 3 Setup Type selection 

 

4. Click Next button. The dialog for selecting the installation directory appears (Figure 
4). Use the default or select another installation directory. 

 
Figure 4 Free TriCore Entry Tool Chain Setup folder dialog 
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5. Click Next button. Select the name of the Program Group and 

 
Figure 5 Set Program Group 

 

6. Click Next button. (Figure 6) 

 
Figure 6 Ready to Install dialog 
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7. Click Next. Further dialogs inform you about the progress of installation. 

 
Figure 7 Installation Complete 

 

Note: The Free TriCore Entry Tool Chain license is valid for at least one year. There are 
following restrictions of the Free TriCore Entry Tool Chain version in comparison to the 
professional version of UDE: 
- Useable for TriCore evaluation boards with on-board wiggler only 
- PCP assembler only 
- Debugger: 
  - No visualization functions at runtime available 
  - MCDS support not available 
  - Script support not available 
  - GTM support not available. 

Please contact tctcsupport@pls-mc.com for extending the license. 

Please note: For commercial development you need the professional version of 
TriCore Development Platform. 

 
 

 
 

 ! 
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First Starting of HighTec IDE 

Starting HighTec IDE 

1. From the Windows’ Start menu, select All Programs – AURIX(TM) TC3xx - Free 
Entry Tool Chain v4.9.3.0-infineon-1.0 – HighTec IDE or use the Desktop icon 
HighTec IDE. 

2. Now the Eclipse Launcher dialog appears (Figure 8). 

 
Figure 8 Workspace Launcher 

3. Enter the path to the workspace directory e.g. D:\EclipseWorkspace\htc-

workspace. If the directory doesn’t exist, new directory will be created; otherwise 

existing directory will be used as eclipse workspace. New created projects will be 
saved in the selected workspace directory.  

4. You can enable the option Use this as the default and do not ask again. By next 
start last used workspace will be used, skipping the Eclipse Launcher dialog. If you 
want to use other or new workspace. Select from the File menu Switch Workspace. 

5. Click OK to proceed. 

The Welcome view appears. Initially, the HighTec IDE opens with a workbench 
displaying the C/C++ perspective with only the Welcome view visible. This view provides 
some general information and alternative ways to access the online documentation. 
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HighTec IDE opens with the perspective which was last used before closing, except when 
starting up for the very first time showing the Welcome view. Click Get to work to close 
the Welcome Screen. 

6. Click the Get to Work on the left side of the view to go to the workbench. Assuming 
first start of eclipse, HighTec perspective (Figure 9) appears, otherwise last saved 
workbench layout. 

 
Figure 9 HighTec IDE perspective 

 

Content Manager 
The HighTec Content Manager provides easy access to the HighTec’s resource cloud 
repository. You find there project examples, templates and other documents that help you 
to get up to the speed quickly. You can open the HighTec Content Manager as the 
separated window from the HighTec Project Explorer menu Open Content Manager 
(Figure 9). 

 

HighTec IDE Documentation 

The documentation about the HighTec IDE is available in the Eclipse menu Help – Help 
Contents. 
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Create an AURIX/TriCore Project 

C/C++ Project wizard 
This tutorial shows how to create an embedded software project with the AURIX/TriCore 
toolset. It lets you create your own project with an example of an analogue clock on the 
display of the AURIX application kit.  

Set the HighTec C/C++ perspective 
Before creating an AURIX/TriCore project, it is necessary to have the HighTec C/C++ 
perspective on the workbench (Figure 10). By default, this should be the case when you 
start HighTec Development Platform, but if it is not, do the following. 

To open the HighTec C/C++ perspective 

1. From the Window menu select Open Perspective - Other... - HighTec. The name 
of the perspective is displayed in the title bar of the workbench window. 

Create new project 

1. From the HighTec Project Explorer menu select Create HighTec Project (Figure 
10). The New Project Wizard appears (Figure 11). 

 
Figure 10 HighTec Project Explorer – Create HighTect Project 
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2. Select Create advanced project and press Next. 

 
Figure 11 New Example Wizard 

 

3. The next wizard page (Figure 12) shows a selection of examples containing the 
TriCore APPKIT boards supported by the toolchain. Select an example, e.g. TC37x 
BSP example. Press Next. 

 
Figure 12 Example projects – Package Selection 
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4. The next wizard shows the overview about the selected package. Press Finish. 

5. The selected example will be imported and a new projected created. Figure 13 shows 
HighTec perspective with the new created project. To see the generated project files 
you may need to expand the hello project structure on the left pane. To open one 
generated file double-click the file in the src folder of the project structure. 

 
Figure 13 HighTec C/C++ Perspective with the new imported example 

Start with an empty Project 

Open the HighTec Project Wizard (Figure 11) and select an empty project. Follow the 
wizard for creating the empty project step by step. 

Build the Project 
When you build an AURIX/TriCore C/C++ project in HighTec Development Environment, 
the HighTec TriCore compiler, assembler and linker are used to compile and link all the 
source code and the libraries associated with the project.  

The wizard generates different build targets like iROM (default). You can choose a build 

configuration by clicking the arrow of the build icon and build a target by clicking the 

build icon  when available. 
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Meaning of build targets 

➢ iROM Code will be located in the internal flash (default) 

During the build process the sources belonging to the project will be compiled and linked. 
The messages occurring during the build process are displayed in the Console window 
(Figure 14).  The build process should terminate without giving any errors or warnings. 

 
Figure 14 HighTec C/C++ Perspective: Build button and Console window 
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Connecting the Target 

TriBoard with mounted TC38xA, TC39xA, TC39xB 
processor 

1. Configure the DIP switches (1,2,3=OFF 4=ON but for A step (!) 1=ON 2,3,4=OFF)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard. 

3. Connect the TriBoard to the PC via a Micro-USB cable (a cable is supplied with the 
Starter Kit). 

4. Three Power LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 15 AURIX – TriBoard 
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AURIX Application Kit TC387, TC397 TFT with TC38xA, 
TC397A, TC397A (ADAS), TC397B 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC397 to the PC via a Micro-USB cable (a cable is 
supplied with the Starter Kit). 

3. The Power LED should be on. 

4. Press the RESET button (see picture below). 

 

 
 

 

 

 

Back side Top side 

 
Figure 16 AURIX Application Kit TC397 TFT 
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AURIX Radar Baseboard TC35x 60GHz  

1. Connect a VBatt DC power supply (12V) to the AURIX Radar Baseboard. 

2. Connect the Radar Baseboard to the PC via a Micro-USB cable (a cable is 
supplied with the Starter Kit). 

3. The Power LEDs on the backside should be on. 

 

 

 
Figure 17 AURIX Radar Baseboard 
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AURIX Lite Kit V2  with mounted TC265, TC275, TC365, 
TC375 processor 

1. Connect a DC power supply (5V – 40V) to the AURIX Lite Kit V2. 

2. Connect the AURIX Lite Kit to the PC via a Micro-USB cable (USB 3.0 recommend, a 
cable is supplied with the Starter Kit). 

3. The Power LED should be on. 

4. Press the RESET button (see picture below). 

 

 

 
Figure 18 AURIX Lit Kit V2 
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TriBoard with mounted TC2D5T, TC21xA, TC22xA, 
TC23xA, TC26xA, TC26xB, TC27xA, TC27xB, TC27xC, 
TC27xD, TC29xA, TC29xB processor 

1. Configure the DIP switches (1,2,3=OFF 4=ON but for A step (!) 1=ON 2,3,4=OFF)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a Micro-USB cable (a cable is supplied with the 
Starter Kit). 

4. Three Power LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 19 AURIX – TriBoard 
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Application Kit AURIX TC2X4 TFT with TC224, TC234 
(TLF35584A, TLF35584B, TLF35584C) 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X4 to the PC via a Micro-USB cable (a cable is 
supplied with the Starter Kit). 

3. The Power LED should be on. 

4. Press the RESET button (see picture below). 

 

 
 

 

 

 

Back side Top side 

 
Figure 20 AURIX Application Kit TC2X4 TFT 
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Application Kit AURIX TC2X5 TFT with TC265B, 
TC275A, TC275B, TC275C  

 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X5 to the PC via a Micro-USB cable (a cable is 
supplied with the Starter Kit). 

3. The Power LED should be on. 

4. Press the RESET button (see picture below). 

 

 

 

 

Back side Top side 

 
Figure 21 AURIX Application Kit TC2X5 
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Application Kit AURIX TC2X7 TFT with TC237, TC267B, 
TC277C, TC277D, TC297B 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X7 to the PC via a Micro-USB cable (a cable is 
supplied with the Starter Kit). 

3. The Power LED should be on. 

4. Press the RESET button (see picture below). 

 

 

 

 

Back side Top side 

 
Figure 22 AURIX Application Kit TC2X7 
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ShieldBuddy TC275C, TC275D 

1. Configure the Power Supply Jumper to VUSB.  

2. Connect the ShieldBuddy to the PC via a Micro-USB cable (USB 3.0 recommend, a 
cable is supplied with the Starter Kit). 

3. Three Power LEDs should be on. 

4. Press the RESET button (see picture below). 

 

 
Figure 23 ShieldBuddyTC275 
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phyCORE-TC29xB with Baseboard 

1. Connect a DC power supply (5.5V – 60V) to the baseboard 

2. Connect the baseboard to the PC via a Micro-USB cable (a cable is supplied with the 
Starter Kit). 

3. The Power LED should be on. 

4. Press the RESET button (see picture below). 

 

 
Figure 24 phyCORE – TC29xB with Baseboard 
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phyCORE-TC39xB with Baseboard 

1. Connect a DC power supply (5.5V – 60V) to the baseboard 

2. Connect the baseboard to the PC via a Micro-USB cable (a cable is supplied with the 
Starter Kit). 

3. The Power LED should be on. 

4. Press the RESET button (see picture below). 

 

 
Figure 25 phyCORE – TC39xB with Baseboard 
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TriBoard with mounted TC1767 processor 

5. Configure the DIP switches (default all OFF - boot from internal flash)  

6. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

7. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

8. Three Power LEDs should be on. 

9. Press the RESET button (see picture below). 

 

 
Figure 26 TC1767 - TriBoard 
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TriBoard with mounted TC1797 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 27 TC1797 - TriBoard 
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TriBoard with mounted TC1782 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 28 TC1782  - TriBoard 
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TriBoard with mounted TC1724 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 29 TC1724  - TriBoard 
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TriBoard with mounted TC1791 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 30 TC1791  - TriBoard 
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TriBoard with mounted TC1793 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 31 TC1793  - TriBoard 
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TriBoard with mounted TC1798 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the RESET button (see picture below). 

 

 
Figure 32 TC1798 - TriBoard 
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phyCORE-TC1793 with Baseboard 

1. Connect a DC power supply (5.5V – 60V) to the baseboard 

2. Connect the baseboard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the RESET button (see picture below). 

 

 
Figure 33 phyCORE - TC1793 with Baseboard 
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Debugging your Application 

Start a Debug Session  

1. Click at the debug button  and select Debug Configurations ... (Figure 34). 

 
Figure 34 Select Debug Configurations dialog via Debug button 
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2. The Debug Configurations dialog appears. Select Universal Debug Engine as 
debug type (Figure 35). 

 
Figure 35 Debug Configurations dialog 

3. Press the New configuration button to create a new debug launch configuration for 
Universal Debug Engine (Figure 36). 

 
Figure 36 Create new debug launch configuration for Universal Debug Engine 

4. A new debug configuration tc37x_bsp_example_iRom is created. All input fields are 
pre-filled with appropriate values (Figure 37). 
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Figure 37 Create new debug launch configuration for Universal Debug Engine 

5. Push Debug to start UDE perspective. Later you can use the Debug icon . 

6. If you built an iROM version of your application, the UDE Memory Programming 
Tool will appear after launching the UDE perspective (Figure 38). 

 
Figure 38 UDE Memory Programming Tool 
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7. Start flashing with the Program button. A progress dialog appears (Figure 39). After 
successful programming close both dialogs via Exit. 

 
Figure 39 FLASH programming progress dialog 

Note: If a problem occurred pop-up window appears, click OK, check the USB cable 
connection, reset the board with the reset button, and start again the Debug session. 

8. From the Debug menu, select Step over subroutine, or click on the Step over 

button  in the toolbar. At this moment your application is executing but stopped 
on the function main(). This means the C startup code has been executed 

completely. The Editor view shows the C source files of your application and a yellow 
arrow shows the line where the execution has stopped (Figure 40). 

 
Figure 40 First step to main() function 
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Stepping through the Application 
1. From the Debug menu select Step over subroutine or click on the Step over button  

 in the toolbar. The yellow arrow in the Program view moves to the next 
statement. 

2. To set or clear breakpoints click on the markers in the info margin of program 
window. 

3. To see watch or local variables please open the accordingly window 
via the View menu. 

4. To run your application, select Start Program Execution from the Debug menu or 

click on the Start Program button  in the toolbar. Now an analogue clock should 
be visible on the display of the application kit. 

5. To restart your application, select Restart Program Execution from the Debug 

menu, or press F7 or click on the Restart button  in the toolbar. 
 

Using the UDE debugger 
The main() and further features of UDE are described in the UDE Manual, available via 
UDE Welcome Page. Open it via menu Window - Show View - Other ... - Universal 
Debug Engine - UDE Welcome Page and push the UDE Manual button.  

Figure 41 shows an UDE example configuration with Peripheral Registers, Call stack, 
Watch window, and Memory window. All features are described in the UDE Manual. 

 
Figure 41 Universal Debug Engine perspective 
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End the Debug Session 

From the File menu select Close Workspace or click on the Close Workspace  button 
in the toolbar. The current perspective is switched back to the HighTec C/C++ 
perspective. 

 

 

 

 

 

 

Summary 

Having followed the step-by-step instructions the development environment comprising 
AURIX TC3xx Free Entry Tool Chain and AURIX/TriCore Family Evaluation Board will 
have now been installed. After creating and compiling a simple program, it is successfully 
executed on the Evaluation Board. 

You now have a running environment that could be used for further development or 
evaluation work.
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